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Understanding Final Cut Pro X 10.2 Libraries and Events 
The file management system in Final Cut Pro X (FCPX) 10.2 is based around libraries and events. A 
library can be located anywhere on any drive internal or external. It contains all working files, both 
raw/original files and render and project data. A library can easily be copied or transferred to another 
drive, its best practice to contain all working files inside the library and not have any files referencing 
outside the library. However depending on the size of your project files, this may not always be feasible. 
For example if you are working with 200GB+ combined files you may decide to reference your original 
files from another disk.  

An Event acts like a parent folder inside a single library, it can contain raw media, and projects. You can 
have multiple events in a single library. 

The diagram below illustrates the library and event structure: 
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What does the viewer window do? 
The Viewer window is where your project is displayed. It’s 
the area where you can manipulate titles, transform video 
and reposition it, perform key framing and watch your video 
in full screen. 

 

 

What does the Inspector do? 
The Inspector is the Key to all your settings. Using short cut 

keys ‘Command + 4’ or the   

It shows 3 main types of information: Video. Audio and Info. 

The video inspector is where colour correction occurs, where you can 
transform your clips, crop, distort and many other video manipulations. 

The audio inspector is where you can edit sound, make it louder and 
split it into 2 tracks. 

The Info inspector is where you can see what metadata there is about a clip or project. 

Importing Media from an SD Card 
or iPhone or iPad 

File > Import > Media.  

Plug your ipad or iphone into the mac and it should 
appear in the list, select the video files and import 
them. 
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Selecting In & Out Points in your Event Library 
Once your media has been imported into your event library, you can begin to sort through it. 

Use your mouse to skim through the video clips, when you find a part of the clip that you 
want to highlight or designate, press ‘i’ on the keyboard to start a range point in, then 
play or scroll through your footage to another point and press ‘o’ on the keyboard, which 
will insert a range out point.  

Projects, Editing Basics 

 
Projects 
Projects are stored inside events, multiple clips from multiple events can be in a 
single project, however all clips in the project must exist inside the same 
library. Projects are listed at the top of an event. To create a new project: File > 
New > Project 

The popup window will ask you to type a new project name and related event and then some options for 
the project’s resolution when you click on: . The settings should be set to this: 
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The Primary and Secondary storylines 
The primary storyline is the line of clips located over the main strip of black in the timeline, any clips, 
sound tracks, titles are connected to it, you can have secondary storylines which are also attached to the 
primary storyline, so that you can use transitions. This type of editing is called Non-Linear Editing 
(NLE). To move the connection point, hold down command + option and click on the connection clip on 
the place you want it to be moved to. 

 

Inserting media into the project timeline 
There are multiple ways of inserting media into the project timeline, first select a range from a clip in the 
event library by either click and dragging across a clip or setting in and out points or the entire clip, first 
you can simply drag and drop the clip into the timeline. We also have 3 different insert shortcuts: q, w, e. 

 

    Q     W      E 

Each one does something slightly different, have a look at the image and see if you can guess how the 
inserted clip will be placed in the timeline. 

What is background rendering? 
Background rendering occurs when transitions or edits needs to be “dried” after “gluing”. When you 
make an edit sometimes it will need to render before it will play back smoothly, this will usually occur for 
titles, transitions and any attached video clips. The rendering runs in the background and any other tasks 

will show up when you click on this:  
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Transitions and Effects 
Transitions can be found by using the Effects menu set.  There are 4 different types of effects: 

• Video Transitions 

• Video Effects 

• Audio Transitions 

• Audio Effects 

The most common Video transition is called ‘Cross Dissolve’, this transition merges the video of 2 clips 
so that its transparency is increased and decreased on each clip so that it flows nicely from one clip to 
another. 

Video Filters include colour correction, stylizing and edging to name a few. 

The Default set for most users is the Cross Dissolve for both Video and Audio.  

Adding a transition to the storyline 
There are a couple of ways in which you can add a transition to the storyline. The one listed here is only 
one way. 

Open the transition window:  

Drag any transition to the gap between the 2 clips:  

Once the transition is placed on the storyline it should look like this:  
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You can drag the cross dissolve object to make the transition longer, however sometimes this doesn’t 
work due to clip duration times. 

Precision Editor 
The precision editor is accessed by clicking on a transition and pressing “Control + E” or double clicking 
on the transition. The precision editor allows you to edit the length of a transition, what part of the clip 
either side of the transition is used, when you are done editing, you can simply close the editor using 
“Control + E” again. 

Snapping:  
Final Cut Pro has a nice feature called snapping, snapping is what occurs when you place 
the playhead near the beginning or end of a clip or transition or cut, this feature will also 
“snap” your mouse to that spot on the timeline. It’s great when you want to get a clip or 
transition exactly next to the other clip without inserting any black frames. Usually 
snapping occurs when you see the playhead change colours to yellow. 

 

 
 

Adding effects to a clip 

Adding filters to a clip is done by selecting the icon:  

As you can add transitions between clips, you can drag and drop effects 
on top of clips. 

The most used filters are colour correctors. 

 

Selection and Blade tool 
The Selection tool (A) is the most widely used mouse tool, but there are other tools 
you can use to edit your clips, such as the blade tool (B) which will cut your clip in 
half. Trim (T) will allow you to shorten or lengthen your clips. These are the 3 main 
tools you will need to use, feel free to experiment with the other tools as well. 

 

Transforming clips 
Select a clip that you’ve positioned as a connected clip. Once the clip is selected, click on this icon in the 

viewer:  (bottom left of viewer window). 

Now you should see a blue transform box, which you can scale, reposition and rotate, in a later tutorial 
you’ll be taught how to “key frame” positions like a flash animation. 
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Auto save 
Final Cut Pro X will automatically save your project, once you create your project it will continuously 
save your work.  

Inserting audio and increasing or decreasing audio levels 
Audio editing will be covered in the next tutorial in more depth, but for the purposes of inserting an audio 
backing track and adjusting the levels, you can import and insert an audio clip just the same as a video 
clip, it will appear in the event as a green clip. Once the clip is inserted in to the storyline below the 
primary storyline, you can adjust the volume of that clip by dragging down the feint black line you can 
see. 

 

 

 

 
 

Audio Editing, Enhancing, Titles and Custom 
Resolutions 

Copyright free sounds 
There’s a website called the Free Music Archive, where you can find and download mostly royalty free 
music: http://freemusicarchive.org (Most songs have a creative commons license attached to it) 

The nice thing about these websites is that it has a lot of music and its all categorized rather nicely, there 
are other paid royalty free sound libraries; another that I use is called AudioBlocks (http://www.audio 
blocks.com). 

Checking sound levels using the audio meters 
You need to check your sound levels once you’ve finished, you can do that by checking in 
the audio meters window, that way you can control all of your tracks rather than having to 
go through each track after you’ve put in fades and other things. Be mindful that appropriate 
levels usually hover around -6 to -12 dB (decibels). The audio meters are located here: 

 and if you click on this area the meters will enlarge and appear to 
the right side of the project timeline. 
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Editing Audio 
Editing audio is done mainly through the inspector. 
Volume – Adjust the volume of the clip 

Audio Enhancements – Allows you to make the audio 
even louder 

Channel Configuration – Allows you to have stereo or 
individual left and right channels, depending on your 
audio setup you may have to split the audio channels 
because you have 2 inputs, one lapel and one boom mic. 

 

 

 

 

 

 

 

J and L Cuts 
A ‘J’ or a ‘L’ cut are the most popular and widely used editing techniques for interviews, it occurs when 
you have audio either starting or ending before the actual talking head appears. Here are examples of J 
and L cuts, you will need to right click on the clip and expand the audio first. 

Fade in and out 
Fading the audio in and out is also relatively simple, drag the handle from the edge of the audio clip, and 
a dark shadow appears illustrating how the audio will dissipate. By right clicking on the handle you can 
choose from other types of fades. 
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Making the audio go up and down in a clip 
You can make the audio become lower or louder by adding key frames to the audio leveller. Hold down 
OPTION key and click on the audio level line, a key frame should appear, you’ll need to create 3 more of 
these points along the line so that you end up with a nice transition of sound. 

 

Once the 4 points are done, drag the line between the 2 inner points and you shall see the lines bend! 

 

You can continue to control these 4 points by click and dragging them. Alternatively by using the Range 
selection tool you can adjust the level of the audio inside that selected range and the 4 key frames will be 
automatically created, however using this method you have less flexibility initially to adjust the 4 key 
framed points along the audio line. 

Adding Titles 

You can add titles by clicking on this icon:  which will bring up this window: 

Once you’ve found the title you want you can drag 
it to the timeline either as a connected clip or as a 
primary storyline clip. 

If the clip is on the storyline the background 
default will be black. 

If you connect it to either a solid color or video it 
will be transparent and the text will layer on top of 
the video. 

Once you’ve got the title in you can use the viewer 
and inspector to adjust position and title properties. 

Some title templates can also be found in the 

 themes browser. 
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Adding background music 
Background music is added in much the same way as video clips, except they exist below the primary 
storyline, and unlike layered video, all audio tracks are played at the same time. They will be connected 
to a clip, so ensure you don’t accidentally delete it when deleting clips. 

Color Grading and Compositing 

 
Color Grading 
This is the process that is commonly done towards the end of your editing and post production process. 
We aren’t expecting you to professionally color grade your films, but it helps to be aware of the features 
available so that you can clean up your footage if need be. Start by selecting any clip in the timeline. Then 
press (Command + 6): 

 The color adjustments panel includes color, saturation and exposure. The 
color board has a positive and negative range, if you need to remove a certain strong color like a yellow, 
try dragging the global circle towards the yellow area in the negative range, ensuring that the playhead is 
positioned over the clip you are editing, so that you can see the changes in real time. If you want to reset 

your changes back to the original, you can click on: . 
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The saturation and exposure levels work similarly, to the color board, moving sliders up or down will 
desaturate or saturate and over or under expose your images. When color grading its important to be 
aware of how bright your computer display is, because if your display’s brightness is low, and then 
you expose a clip brighter, in actual fact it could be too bright. 

Color grading is an enormous topic and if you’d like more information with video tutorials on color 
grading this link will take you to some really great video tutorials: 
https://vimeo.com/groups/165663/videos/26362011  

Paste Attributes 
Pasting attributes is really handy when you’ve set your color or attribute and want to apply it to the rest of 
the same clips in the scene. First copy the clip that has the changed attributes (Command + C), and then 
select a/many clips and (Shift+Command+V) which should bring up this window:  

 

Next you need to select the video and or audio attributes that you would like to paste on to the selected 
clips, for example color or position or crop for ken burns effects. 

Then hit Paste and you should be able to see the changes affected on the clips. You can still edit these 
attributes at a later time. 

Exporting Your Films and uploading to YouTube 
Go to File > Share > YouTube 

You will need to sign in with the login credentials given, then you can choose settings: HD720p will 
suffice. 

Alternatively if the above direct upload method to YouTube fails or you simply want a .mov file of the 
project you can choose Master File instead of YouTube. Go to Settings and make sure the video codec 
says H.264 then you can proceed by selecting: Next and save the file onto your USB stick or the Desktop. 

You can also use this master file to upload to YouTube using the online YouTube website. 

 

 


